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Overview 

This Technician’s Installation Packet (Tech Pack) outlines the responsibilities of the local 
technician, and how support can assist. This document covers recommended hardware, 
network, and software configurations. It also contains information on configuring OrthoTrac, a 
Sensei product, as well as migrating the data to a new server, and maintaining and backing up 
data and files for OrthoTrac. 

OrthoTrac is a critical systems application that must be running every day with as little down 
time as possible. In addition to the application, the hardware is critical to ensuring the stability of 
an automated practice management system. Our hardware recommendations follow what has 
been tested. Carestream Dental is only able to test OrthoTrac in a limited number of 
environments. OrthoTrac support will work with you as best as we can if you are not following 
our recommendations, but we will be limited in modifications we can make to get OrthoTrac 
working in environments that do not meet the requirements listed in the current Systems 
Requirements. 

Carefully read and follow the installation instructions in the Installation Guide and 
recommendations contained within this Technician’s Installation Guide. If you have any 
questions, contact OrthoTrac support. 

Technician Acknowledgement 

The local technician is fully responsible for the configuration, installation, and maintenance of 
the client's computer network. Our company does not support the installed network or its related 
issues, including printer installations or operations. 

The local technician is fully responsible for making sure the hardware is configured and the 
client is trained to save and restore a backup of the OrthoTrac data and all necessary files for 
OrthoTrac. Since there are many types of backup programs, OrthoTrac support does not train 
offices on configuring the backup system or restoring a database. If an office must send data to 
OrthoTrac support for in-house analysis, send backups on external hard drives / flash media, or 
internet transfers. No other forms of backup media are accepted for data analysis. Addendums 
to installation documents will be made as necessary. 

The local technician is fully responsible for the support and maintenance of the client's computer 
network system. Give your clients your contact information and specific instructions to contact 
you first for system-related problems. Any questions about optimizing the network environment 
for use with OrthoTrac products are welcome. It is recommended that you be familiar with the 
client’s Windows operating system and carry an MCSE (Microsoft Certified Systems Engineer) 
certification or equivalent on staff. 

OrthoTrac representatives are highly trained and capable of assisting you to ensure a smooth 
software/hardware installation and systems upgrade. When contacting support, be sure to have 
the client’s account or phone number ready. 

Questions can be emailed directly to orthotracsupport@csdental.com or call support at 
866.722.2567. 

mailto:orthotracsupport@csdental.com
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System Requirements, Installation Basics, and Configuration 

Before installing OrthoTrac or migrating the data, review the following items in the Resource 
Library: 

• System Requirements – Review before proceeding to ensure the hardware meets or 
exceeds the current requirements. For questions on versions of Windows, peripherals, 
third-party software versions, and other software requirements, reference the OrthoTrac 
system requirements. 

o Locally Hosted or Shared Server System Requirements 

o OrthoTrac Cloud System Requirements 

• Configuration Guide – Review the current configuration recommendations. 

• Installation Guide – Follow the steps to perform an upgrade or new installation. 

OrthoTrac Installation Guide 

This guide is meant as a supplement to the OrthoTrac Installation Guide. The installation 
guide contains the most recent step-by-step instructions. In addition to the Resource Library, a 
copy of the OrthoTrac Installation Guide is located in the following locations: 

• Documentation\Manuals\OR200_OrthoTrac_InstallationGuide.pdf on the installation 
ISO 

• OMS\OnlineDocs\OR200_OrthoTrac_InstallationGuide.pdf on an existing server 
installation 

Basic Installation Steps 

1. Install OrthoTrac on the server. 

2. Share the parent folder of the installed OMS folder. 

3. If the office is using Carestream Dental Orthodontic Imaging, install imaging on the 
server. 

4. Restore any existing data. 

5. Map workstations to the shared folder on the server. 

6. Install OrthoTrac on the workstations. 

7. If the office is using Carestream Dental Orthodontic Imaging, install imaging on the 
workstations. 

8. Install OrthoTrac on any Remote Desktop Services servers. 

9. If the office is using Carestream Dental Orthodontic Imaging, install Orthodontic 
Imaging on the Remote Desktop Services server. 

Office Configurations 

There are several ways OrthoTrac can be configured. Generally speaking, an office, regardless 
of the number of locations, will want to keep all of their locations together in one data set. In 
cases where the client wants to house multiple data sets to further separate their offices, 
assistance may be required from a support representative for installation and support. 

https://gosensei.com/pages/resource-library
https://gosensei.com/pages/resource-library
https://cdn.shopify.com/s/files/1/0573/0821/7483/files/OrthoTrac_v15.3.1_System_Requirements.pdf?v=1691781859
https://cdn.shopify.com/s/files/1/0573/0821/7483/files/OrthoTrac_v15.3.1_Hosted_System_Requirements.pdf?v=1691781859
https://gosensei.com/pages/resource-library
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Single Locations 

A single office location is typically configured with a server that houses the OrthoTrac data and 
multiple workstations that run OrthoTrac locally and connect to the OrthoTrac server over the 
network. The server runs an instance of Microsoft SQL Server; by default OrthoTrac v12 and 
v14 will install MS SQL 2008 Express. Version 15 will install MS SQL 2014 Express. We 
recommend allowing OrthoTrac to install the Express edition of SQL. If you will require the use 
of a full version of SQL during the installation process, you will be presented with an option to 
direct OrthoTrac to use an existing SQL instance during the server install. The server also 
houses a number of files that are accessed by the workstation. 

If the practice will be using Carestream Dental Orthodontic Imaging, we recommend having a 
separate server to house the imaging data. This should be a separate physical server. It is 
preferable to have two individual servers house the data for both programs than to virtualize 
both the OrthoTrac and imaging servers and run them on the same host. 

Note: SQL Server Express Editions are restrictive on database size and RAM/CPU usage. 
These restrictions could affect performance. Consult Microsoft for SQL Server version 
specifications to make sure that an Express edition is right for your practice. 

Multiple Locations 

Clients who have multiple locations and want to share a single data set between the locations 
will need to use remote access software to connect the locations. We recommend installing the 
OrthoTrac data server in the largest office, along with a Remote Desktop or Citrix server, and 
have remote users connect to the server through Remote Desktop Services to run OrthoTrac. 
The remote office does not actually run OrthoTrac locally; the application is run in the main 
office on the Remote Desktop server. Carestream Dental has not tested running OrthoTrac 
between two offices using a VPN connection. 

Imaging in Multiple Locations 

Adding Carestream Dental Orthodontic Imaging with multiple office locations increases the 
variables and methods of setting up the office. We recommend discussing the options with 
Carestream Dental Orthodontic Imaging support or implementations team prior to setting this 
up. Some questions to consider before contacting support are: 

• Will images acquired in one office need to be accessible in all offices? 

• What digital imaging equipment will be used in each office? 

• What internet connections are available in each office and what is the bandwidth? 
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OrthoTrac Installer File for Locally Hosted Offices 

Beginning with version 15.1.3, the OrthoTrac Installer is available for download via the Dental 
Practice Management Software Download Service. 

Important: The file on the Dental Practice Management Download Service is for your 
practice only and is unique to your login. The download will expire after 24 hours. 

1. Save the OrthoTrac Installer file to the server. 

2. Follow the procedures in this document to install or update OrthoTrac. 

Download the Installer Files 

1. On the server, go to https://softwaredownload.csdental.com/en-US/. The Dental Practice 
Management Software Download Service login window is displayed. 

2. Enter the Customer ID and Zip Code. 

3. Click Submit. The installer file download is displayed, along with instructions. 

4. Click Download and save the file to the default download location. 

Installation and Migration 

Whether a client is a new or existing customer, before data can be applied for an office, the 
server that will house the data must have OrthoTrac installed in the proper location. OrthoTrac 
must be installed before Carestream Dental Orthodontic Imaging is installed. This enables the 
two programs to communicate properly. 

It is also recommended to call support a few days before your planned update or install to 
schedule a representative to work with you during the transition. When migrating data, we also 
recommend decommissioning the old server if at all possible, or at least, stopping services for 
the SQL instance running OrthoTrac. 

Installing OrthoTrac On a New Server 

All workstations must be able to access the OMS parent folder on the server. If you do not want 
to share the root of the C:\ drive on the server, be sure to change the destination folder during 
the installation process. Do not install to C:\OMS then move folders. This will break the 
ability for a workstation to create a backup copy of the OrthoTrac data and will cause problems 
updating the server. For instance, if a client wants to install OrthoTrac on D:\data, you must 
install OrthoTrac to D:\data\oms and D:\data\oms-spec, sharing the D:\data folder on the 
network. Then map the network drive on the workstations (generally U:\) to the shared data 
folder on the server. 

Before installing, OrthoTrac searches all local hard drives for an existing installation of 
OrthoTrac. With a new server install, it is recommended that you wait for this process to 
complete. There is a work around noted in the Server Updates section of this document. 

If you are using Windows Firewall, be sure it is on when OrthoTrac is installed. There are 
exceptions that must be made for SQL. These exceptions are made automatically if the 
Windows Firewall is on during installation. If you are not using Windows Firewall, then you will 
need to manually add exceptions for SQL to the firewall. 

https://softwaredownload.csdental.com/en-US/
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Migrating an Existing Version 11 or Higher Server to a New Server 

1. Verify all users are logged out of OrthoTrac. 

2. Start OrthoTrac on the server. 

3. Have a staff member log into OrthoTrac. 

4. Select File > Prepare Backup. 

5. Wait for the Prepare Backup process to complete. 

6. Select Options > Environment. 

7. Note the Server Path (default is C:\OMS) and Database Prefix (default is Main). 

8. Browse to the server path\backup\Most_Recent folder. 

9. Verify the backup files exist for each database. 

The file name structure is prefix_dbname_yyyymmdd_xxx.bak. The prefix is the 
database prefix from environment. There are five databases for OrthoTrac, named 
Audit, CommCat, DelOMS, OMS, and TxCard. The xxx is the backup count; the first 
backup of the day is 001. For example: Main_OMS_20130505_001.bak 

If the client is using Carestream Dental Orthodontic Imaging v10 or higher: 

• Run pwisetloc.exe. 

• Note the SQL backup location. 

• Browse to the SQL backup location. 

• Verify there is a Most_Recent folder that contains a 
prefix_PWImage_yyyymmdd_xxx.bak file. 

10. Close OrthoTrac. 

11. Right-click on the key icon in the system tray. 

12. Click Exit PracticeWorks Server. 

13. Install OrthoTrac on the new server. 

14. Copy the following files from the old server to the OMS folder on the new server: 

• \OMS\pwsvr\pwlf.dat 

• \OMS\*.000, C:\OMS\*.001, C:\OMS\*.002, etc. 

• \OMS\filelist.nrl 

Note: By default, files with filename extension, such as .000, .001, .003 and .nrl, as 
listed above, are set to be hidden by Windows. You will need to set Windows to view 
all files including hidden or system files in order to see these files. 

• \OMS\Fingerprint.mdb 

• \OMS\roll*.txt 

• \OMS\AuditTx.dat 
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15. Copy the following folders from the old server to the OMS folder on the new server. 
Some of the folders listed may not exist on the old server: 

• \OMS\ACH 

• \OMS\Backup 

• \OMS\Daysheet 

• \OMS\Docs 

• \OMS\ECS 

• \OMS\Epayment 

• \OMS\ICCPS 

• \OMS\Snapshot 

• \OMS\ToothCht 

• \OMS\Orthometrics 

16. If the new server will be the imaging server, copy the following folder from the old server 
to the OMS folder on the new server: 

• \OMS\image 

17. On the new server, run the URestore utility located in the c:\oms-spec\utility folder. 

• Agree to the notification page. 

• Click Next. 

• Deselect the Perform backup option. 

• Click Next. 

• Select the Most_Recent folder from the backup folder just copied. 

• Click Next. 

• Continue through the procedure to restore the most recent copy of the office’s data 
to the new server. 

18. Set the workstations to look to the new server. 

• Remap the network drive for OrthoTrac to the parent folder of the OMS folder on the 
server. 

• Verify all references to the old server are renamed in c:\windows\OMS.ini. 

• Select Options in c:\windows\system32\pwclient.exe (syswow64 for 64-bit 
installations). 

• Verify the path is set to the new server. 

• Run c:\oms\pwisetloc.exe. 

• Verify the proper data locations are selected. 
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Migrating an Existing Version 10 to a Version 11 or Higher Server 

We recommended that you work with support before migrating to a new server. OrthoTrac 
versions previous to version 10 must be updated incrementally. However, version 10 and later 
can be directly updated to the most recent version. Version 10 of OrthoTrac and previous 
releases did not run on modern Windows operating system releases, so support will have to 
manually update the datasets on the new server. The steps will be the same as the previous 
section; however, step 17 will require support assistance to update the MDB files from the old 
server’s OMS folder to version 11 or higher data. 

Note: Since the process is a transition between two different data structures, it may take several 
hours. 

New Workstation Installations 

Prior to installing OrthoTrac on a workstation, log in as a user with the correct administrative 
access to the server machine, and confirm the machine has a logical drive U:\ mapped to the 
appropriate share containing the OMS and OMS-Spec directories on the server. Do not map the 
U:\ drive directly to the OMS folder. It will prevent the workstation from updating correctly. If a 
drive other than U:\ is used, adjustments to the OMS.ini file located in C:\Windows must be 
made, as by default the workstation installation of OrthoTrac creates an OMS.ini file that 
expects the use of the U:\ drive designation. 

Notes: 

• The OrthoTrac support center expects the mapped drive to be U:\ and using anything 
other than U:\ could increase the amount of troubleshooting and time spent working on 
any issues. 

• In all installations, the DataPath= line in the [Awps] section of the OMS.ini file should 
always point to the local installation of OrthoTrac. For example: DataPath=C:\OMS 

Installation Across the Network 

OrthoTrac can also be installed across the network. The advantage of installing OrthoTrac 
across the network is that it will automatically set the locations in the OMS.ini. 

This solution assumes the server is named Server and you are installing OrthoTrac on a 
workstation that is already connected to the network with proper permissions to access the 
server. This solution also assumes OrthoTrac is installed to the c: local disk drive on the server 
and that the c: drive on the server is mapped as the U: drive on the workstation. When installing 
on a system where these assumptions are incorrect changes must be made. 

1. From the Windows desktop, click Start > Run. 

2. Type: U:\OMS-SPEC\Workstation Setup. 

3. Click OK. 

4. Double-click wsetup.exe. When the installation is complete, the system prompts for a 
reboot. 

5. After the computer has rebooted, log into OrthoTrac to confirm the installation was 
successful. 
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New Terminal Server Installation/Citrix Environments 

Installation to a Terminal Server or Citrix environment is similar to a regular workstation 
installation. However, the Terminal Server MUST be in install mode, and must be installed from 
the administrator’s console session. Windows install mode can be set simply by using the 
command change user /install, making sure once the installation is complete to return to 
change user /execute. An OMS.ini file is placed in each user’s %userprofile%\windows 
folder instead of the local C:\Windows folder. See the Microsoft Word in a Terminal 
Server/Citrix Environment section for details on setting up the office to print letters in a 
Terminal Services environment if the office will be printing letters directly from their Terminal 
Server. 

Licensing and Registration 

Before removing any software from the old server, copy the contents of the PWSVR folder 
which contains the license file. 

Notes: 

• This PWSVR folder is normally installed within the OrthoTrac folder on the data server. 
This location may vary if the office is using Carestream Dental Orthodontic Imaging. 

• Install the license file on the new server before installing the software on the 
workstations. 

• If you do not have a current copy of the license file, contact support. The support team 
can either send a copy via email or connect to the server and upload a copy. 

Installing the License File 

When a prompt to install the license file is displayed while installing or opening OrthoTrac, do 
the following: 

1. Browse to the location of the saved PWSVR file. 

2. Select the file. 

3. Click OK. 

Registering the Software 

When a prompt to register the software is displayed while installing or opening OrthoTrac, 
register the software using one of the following methods: 

• Register online via the internet 

• Contact support by phone 

Note: If you are unable to register the software at this time, click Cancel to continue with the 
update. You have seven days to register the product. 

To Register via the Intenet 

1. Select Automatically via the Internet. 

2. Click OK. The Registration Code window is displayed while the code is generated.  
After the registration code is obtained, the Installation Complete window is displayed. 

3. Click Finish. 
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Note: If you have registered the software more than three times, you will be required to contact 
support to receive a registration code. 

To Register by Phone 

1. Select Contact support by telephone. 

2. Click OK. 

3. Contact support using one of the following methods: 

• Call 866.722.2567. 

• Email orthotracsupport@csdental.com. 

4. Provide the Customer ID and Hardware ID information from the Registration window 
when contacting support. These numbers are used to generate the Registration Code. 

5. Type the registration code in the Registration Code field. 

Note: Use capital letters when typing the registration code. 

6. Click OK. The Installation Complete window is displayed. 

7. Click Finish. 

Backup Recommendations 

This section covers recommendations for configuring a backup routine for OrthoTrac data and 
related files. When setting up the backup routine, review the following sections in the OrthoTrac 
Configuration Guide in the Resource Library for more information. 

• Backing Up Data 

• Using a Backup Checklist 

• Establishing a Backup Routine 

• Managing Files and Backup Media 

Note: If the data was installed in a location other than the default directory, configure the 
backup system to back up the actual data location. 

Backing Up the Server 

IMPORTANT: It is the client’s responsibility to make sure they have a current backup of 
the OrthoTrac data. 

We recommend making a backup during lunch and at the end of each working day. 

The recommended methods for backing up data include online backup services and tape 
backup. 

Note: Flash drives and CD-RWs have been found to be inconsistent in testing due to 
degradation. Whichever backup solution is used, it is best to ensure the media is removed from 
the office at the end of the day or kept in a fireproof safe. 

Prior to running the system backup, the user should go to File > Prepare Backup from the main 
menu of OrthoTrac. This process creates .bak files of the OrthoTrac databases in the 
\OMS\Backup\Most_Recent folder. These files can be used to easily restore OrthoTrac data. 
Keep in mind these files are not the only ones that should be backed up and because this 
‘backup’ is on the same hard drive as the original file, it is not a ‘true’ backup. The Prepare 
Backup process can also be automated by scheduling Windows to run the file 
OMS\Orthobac.exe. Because SQL runs using .MDF and .LDF files to store the physical data 

mailto:orthotracsupport@csdental.com
https://gosensei.com/pages/resource-library
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and SQL may hold these files with a system lock sometimes preventing backup, we recommend 
skipping these files in the daily system backup and ensuring the \OMS\Backup folder, instead, 
is copied in the actual backup process. 

If a scheduled backup is used, be sure to schedule the Prepare Backup feature, or schedule 
the Orthobac.exe process, prior to the actual file backup. We also recommend reading over the 
backup log each morning to ensure consistency. 

Tape Backups and Backup Frequency 

When using a tape backup, keep the following in mind: 

Keep two lunch backup tapes, one tape for each working day and two weekly tapes. For 
example, if the office is open Monday through Thursday, you would have two lunch backups 
that are used every other day, four daily backups and two weekly backups that would be used 
every other week. 

We also recommend you do an end of month backup. It is a good idea to keep two end of 
month backups at all times. For example, at the end of January, you should have a January end 
of month backup as well as a December end of month backup. 

Because backup media can malfunction or go bad, it is also a good idea to keep a spare backup 
tape in the event that one of the daily, weekly, or end of month backup tapes are unusable. 

We recommend taking physical backup devices off site when the office closes for the night in 
case of fires, flood, or other possibilities of system damage. 

Be sure the client is trained to configure and use their backup system. 

Recommended Files to Back Up 

Minimum recommended lunch backup files are: 

• C:\OMS\Backup\Most_Recent\*.* 

Minimum recommended daily backup files and folders are: 

• C:\OMS\Backup\Most_Recent\*.* 

• C:\OMS\Fingerprint.mdb 

• C:\OMS\Daysheet 

• C:\OMS\Docs 

• C:\OMS\Snapshot 

• C:\OMS\Toothcht 

• C:\OMS\ECS 

• C:\OMS\ICCPS 

• C:\OMS\ACH 

Minimum recommended weekly backup folders are: 

• OMS folder location, generally: C:\OMS 

Minimum recommended monthly backup folders are: 

• C:\OMS 

• C:\OMS-Spec 
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Note: These recommendations do not include backup information for Carestream Dental 
Orthodontic Imaging. 

Updating 

Before updating OrthoTrac, you should back up the server. For more information, see the 
Backing Up the Server section of this document. 

Most updates to OrthoTrac are quite simple. The install media should be inserted in the data 
server machine, which will take the user through the install process. After the data server is 
updated, OrthoTrac should be launched on all local workstations and the console session of the 
Terminal Server in install mode (when applicable). 

Server Updates 

To update the server, download the installation files from the digital download website and 
mount the ISO on the server. 

Note: OSetup.exe should always be run on the server. The update always begins by searching 
the local hard drive for installations of OrthoTrac. 

If the server has a large hard drive, this search can take a while to complete. You can bypass 
the search for an existing installation by launching the WSetup.exe program with the 
/PATH=<installdirectory> switch. 

Note: The switch is case-sensitive and must be all uppercase. For example: D:\WSetup.exe 
/PATH=C:\OMS 

Workstation Updates 

Typically, updating the workstations only requires starting OrthoTrac after the server has been 
updated. If the installation does not begin upon launching OrthoTrac, it can be executed 
manually by running the file U:\oms-spec\workstation setup\WSetup.exe. 

Upgrading Existing Terminal Servers/Citrix Environments 

We recommend disconnecting all users currently logged into the Terminal Server before 
updating OrthoTrac, since the software will not install properly if users are logged into OrthoTrac 
or any portion of the system. Set the console session of the Terminal Server to install mode by 
typing change user /install from a command prompt. Once this is done, launch OrthoTrac from 
the console session, and follow the prompts. If the installation does not begin upon launching 
OrthoTrac, it can be executed manually by running the file U:\oms-spec\workstation 
setup\WSetup.exe. 

Note: After the update is complete, the Terminal Server must be set back to execute mode by 
running change user /execute. 
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Permissions and Settings 

Setting up the Server 

Extra steps may be required as far as configuration of the server. This section includes 
configuration for automatically logging into the server and backing up the server. 

Automatic Login 

OrthoTrac requires the server be logged into the desktop for OrthoTrac to function on the 
workstations, even if OrthoTrac is not going to be used on the server. OrthoTrac licensing runs 
as an application on the console session of the server. While the session can be locked, it 
should never be completely logged out. 

1. Double-click the gold key in the Windows system tray on the server. 

2. Click Options. 

3. Click Automatic Server Logon Configuration. 

4. Type the user name in the User Name field. 

5. Type the password in the Password field. 

6. Click OK to save the changes. 

7. Click OK to close the PracticeWorks Server window. 

8. Verify the computer now logs in automatically when the server is turned on. 

If control over this functionality of your system by OrthoTrac support is not desirable, it may be 
best to contact Microsoft support to find the best alternative to having an administrator 
automatically log into the console session of the server. 

Non-Admin Settings 

OrthoTrac is optimized to run under an operating system user account with administrative 
privileges, as a member of the Administrators group. To run the software without making the 
user account a member of the Administrators group, some changes must be made to the 
restricted user’s permissions. Some additional changes must be made to run specific features. 
This document describes these changes. Generally speaking, where appropriate, these 
changes should include read, write, and modify permissions. 

Global Permissions 

HKEY_LOCAL_MACHINE\Software\PWInc 

Permission to INI files: OMS.ini, etc. 

Permission should be granted to all INI files used by the application, including particularly the 
OMS.ini. This is a concern when the INI file is stored in the Windows folder, typical for 
standalone workstations. Under a Terminal Services environment, the INI is stored in the user 
profile, and this is usually not a concern. 

Server Permissions 

HKEY_Local_Machine\Software\Microsoft\Windows\CurrentVersion\Run 
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Workstation Permissions 

Full read, write and modify access to the OMS and OMS-SPEC folder and all of its files and 
subfolders housed on the server, and the c:\oms folder (regardless of install settings) 

Access to System Time 

Limited users cannot change the system time. OrthoTrac requires that computers are set to the 
correct time to ensure certain time-dependent features, such as the Scheduling and Patient 
Flow modules, work correctly. Administrators will have to ensure the time is correct in these 
cases. However, this is a case where limiting user access may be worth considering, as if the 
user accidentally sets an incorrect system time, this can have adverse effects on the Patient 
Flow and Charting modules. 

Features Requiring Registry Edits 

Several features as well may require access to different registry keys and locations. 

Electronic Services 

If a user is using eServices, they must be a full administrator on the machine. 

HIPAA Auto-Logoff: 

• HKCU\System\Microsoft\Windows\CurrentVersion\Policies\System 

Carestream Dental Orthodontic Imaging 

Carestream Dental Orthodontic Imaging (CSOI) recommends users to be given full 
administrative privileges as this listing may not cover the full range, as multiple devices and 
alterations to unique imaging installs may cause further registry entries to be required. The 
IMAGE folder on the server will need full rights. Additionally, the following keys are required, 
though there may be more. Note: It might be under wow6432node where appropriate. 

• HKLM\Software\Practiceworks\Image 

• HKCU\Software\Practiceworks\Image 

Third Party Products 

OrthoTrac integrates with multiple third-party vendors. Some configuration for clients that use 
these products may be required. 

Note: This listing is not a complete list of third-party integrated products used by the office. It is 
used to aid with the most common issues. For a more comprehensive list of third-party products 
integrated with the software, refer to the System Requirements. 

Microsoft Word 

IMPORTANT: OrthoTrac does NOT work with any Office, Home, Student or any web-based 
versions of Word (Office 365).  

We only support Microsoft Word Professional versions for printing letters for the office. For 
acceptable Word versions for your current version of OrthoTrac, see the System 
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Requirements. Because OrthoTrac uses extensive macros in these processes, make sure 
macros are allowed in the Word installation. 

Microsoft Word in a Terminal Server or Citrix Environment 

OrthoTrac makes extensive use of macros when printing Word documents. These documents 
access files that must be unique to each user. In Terminal Service and Citrix environments, 
multiple users are simultaneously accessing the same word processing resources, so these 
environments require a unique database setup for use with Microsoft Word. By default, we use 
W:\. Though the drive location can be changed, we recommend continuing to go with defined 
standards for ease of troubleshooting. The drive location must be seen as a local drive on boot; 
a network drive will not suffice. This guide will also cover the use of the AWPSUTILITY.EXE 
which can automate several parts of this process. This utility is included in versions 12 or higher 
of OrthoTrac. It can be found in the \OMS-Spec\Utility folder on the server. Local word 
processing configuration is performed when launching the program. More in-depth commands 
can be found if needed, but require a code of the day, which can be generated by OrthoTrac 
support if needed. 

Definitions for Microsoft Word in a Terminal Server/Citrix Environment 

Terminal Server – All references in this section to Terminal Server are referring to the server 
the users log in to remotely access their OrthoTrac system. 

Data Server – Data server refers to where OrthoTrac stores Microsoft Word documents, and 
does not necessarily mean where the other data is stored. The data server and the Terminal 
Server may or may not be the same machine. 

Data Files – The following files are used by OrthoTrac to export data from the database and to 
use Word as an intermediary: 

• Envelope.txt 

• Envelope.hdr 

• Omsawps.txt 

• Omsawps.hdr 

Each user must have explicit, unique access to these files, because two users writing to the 
same files at the same time will cause a data mismatch. The files, by default, are stored in the 
OMS folder but for offices using Terminal Services, the files will be stored in a TEMP folder. 

Changes to Be Made on a Data Server 

IMPORTANT: We strongly recommend making a backup of the OMS\DOCS folder BEFORE 
following these instructions. 

We will need to change ALL documents to have W:\TEMP be the primary data location. Macro 
settings in each individual .doc file pulls data from the Word data files. 

The first step towards this change is to modify the OMS.ini on the server. If the server is a 
Terminal Server/Data Server combo, the OMS.ini will be located in 
%userprofile%\windows\OMS.ini for the user currently logged in. Otherwise, it will be located 
in c:\windows\OMS.ini. In the [AWPS] section of the OMS.ini, verify the following lines: 
datapath=w:\temp and datasource=server. 

The program AWPSUTILITY.EXE can be used to set the data source automatically as long as 
the OMS.ini for the user logged in is set correctly. When launching the utility, you can select an 
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individual file, and click Repair Selected Doc(s). You can also Repair All Documents using 
the Support Login and a code of the day, which can be generated by OrthoTrac support if 
needed. 

Changes to Be Made on the Terminal Server 

The file rootdrv2.cmd should be installed if OrthoTrac is installed on the Terminal Server using 
the installmode, but if it is not, it can be edited. This file can be edited using notepad. It should 
contain the following lines: 

Set RootDrive=W: 

Subst /d %RootDrive% >NUL: 2>&1 

Subst %RootDrive% "%userprofile%" 

Do not attempt to set up a W:\ with net use. If a drive other than W:\ is desired, it can be edited 
for use in rootdrv2.cmd. 

ALL USERS must have a Temp folder with all OMS WORD DATA FILES required located in 
their user profile. ALL USER OMS.ini files located in %userprofile%\windows\OMS.ini must 
have datapath=w:\temp and datasource=server set. Adding these changes to the default 
profile will also ensure that these settings are applied to all new users when they are added to 
the system. NO TWO USERS SHOULD EVER BE ACCESSING THE SAME DATA PATH OR 
SESSION, OR ERRORS WILL BE ENCOUNTERED. 

Launching the utility AWPSUTILITY.EXE will attempt to automatically fix all users’ profiles with 
the above information 

Changes to Be Made on All Local Workstations 

Note: The following changes are necessary because even though the local PCs are not using 
WTS, they must still access the AWPS documents using the same path and data source that 
the WTS workstations use. 

1. Create drive C:\AWPSTEMP\TEMP. 

2. Copy all OMS WORD DATA FILES to this location. 

3. Create file wdrive.bat using notepad with the following information: 

• SUBST W: C:\AWPSTEMP 

4. Run the newly created .bat file. 

5. Place the .bat file in the user’s startup folder in their Windows start menu. 

6. Edit the OMS.ini located in c:\windows\OMS.ini. In the [AWPS] section, verify the 
following lines: datapath=w:\temp, and datasource=server. 

Note: Launching the utility AWPSUTILITY.EXE will attempt to automatically perform the above 
settings. 

Antivirus 

If the client maintains a continuous connection to the internet, it is advised that antivirus 
software be installed. If antivirus software has been installed, it is suggested that both active 
scanning of macros and of .doc and .dot files be disabled, as such active intervention can 
disrupt the automation of letter printing using AWPS. We also recommend adding the OMS 
folder on both the workstation and the server, and the OMS-SPEC folder on the server to the 
exclusions list of your antivirus software. Even with these settings in place, support has noticed 
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that several antivirus programs still find “false positives” and quarantine OrthoTrac files. While 
we cannot verify specific settings internally, several inconsistencies have been found with AVG. 

Firewall 

If a hardware or software firewall has been installed, it must not interfere with internal network 
traffic and should only filter traffic between the internal network and the network of the upstream 
internet provider. Additionally, appropriate port mapping may be required by configuring the 
firewall insofar as it is necessary to allow for support to connect using remote administration 
software as discussed in the System Requirements. 

Uninstalling OrthoTrac 

IMPORTANT: Make a backup (see Backing Up the Server) and remove any data BEFORE 
following these instructions. 

OrthoTrac does not come with uninstall media. As such, uninstalling the program involves 
several steps, including editing the registry. If you are not comfortable with this process, call 
OrthoTrac support so that a representative can aid in this process. 

Uninstalling OrthoTrac on a Server 

1. Remove the OMS folder, generally C:\OMS. 

2. Remove the OMS-Spec folder, generally C:\OMS-Spec. 

3. Uninstall SQL. 

• This can be done through the Add/Remove Programs section of the Control Panel. 
You will be given options for removing SQL. 

• Be sure to uninstall the instance of ORSQLEXP. 

4. There are several registry entries that must be removed. Within regedit, remove keys 
from the following locations: 

• HKCU\SOFTWARE\ORTHOTRAC 

• HKCU\SOFTWARE\PRACTICEWORKS\ORTHOTRAC 

• HKCU\SOFTWARE\PWINC\ORTHOTRAC 

• HKEY_USERS\S-1-5-21-*\Software\OrthoTrac 

• HKEY_USERS\S-1-5-21-*\Software\PracticeWorks\OrthoTrac 

5. Remove the file C:\WINDOWS\OMS.ini. 

Uninstalling OrthoTrac on a Workstation 

1. Remove the C:\OMS folder. 

2. There are several registry entries that will need to be removed. Within regedit, remove 
keys from the following locations: 

• HKCU\SOFTWARE\ORTHOTRAC 

• HKCU\SOFTWARE\PRACTICEWORKS\ORTHOTRAC 

• HKCU\SOFTWARE\PWINC\ORTHOTRAC 

• HKEY_USERS\S-1-5-21-*\Software\OrthoTrac 

• HKEY_USERS\S-1-5-21-*\Software\PracticeWorks\OrthoTrac 
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3. Remove the C:\WINDOWS\OMS.ini file. 

Frequently Asked Questions 

Q: Can I run OrthoTrac on Windows 8.1 and 10/Mac/Linux/Unix/OS2 or some other operating 
system not listed in the system requirements? 

A: We only list the operating systems we have tested with OrthoTrac. OrthoTrac only runs in 
Microsoft Windows. We have tested on a Mac using a VM or dual boot, but not any other type of 
Windows emulator. In the past, we have not completed our testing of OrthoTrac on new 
Windows operating systems until the release of the first service pack for that OS. 

 

Q: Will OrthoTrac work running in a virtual server? 

A: While OrthoTrac will work running in a virtual environment, we have not tested in this 
environment, and we have encountered multiple clients who have run into severe data 
connectivity issues when running in a virtual environment. Finally, we have experienced several 
issues involving updating virtual environments. As such, OrthoTrac support’s official policy is 
that virtual environments are unsupported. We would strongly recommend against using a 
virtual environment, and we cannot guarantee we will be able to assist if problems are 
encountered in a virtual environment. 

 

Q: What about Small Business Servers? 

A: OrthoTrac will not work properly on a Small Business Server. 

 

Q: What happens if I use hardware or software that support tells me is not supported? 

A: OrthoTrac support will attempt to remedy situations that may arise from using non-supported 
hardware and software; however, in situations where we cannot find a way to resolve the issue 
with the technology the client is using, we may recommend using supported systems to resolve 
the issue. In all cases where data is involved, we will work with the client to the best of our 
ability to ensure the stability and reliability of their data regardless of technology used. 

 

Q: Can I get the user name and password for SQL? 

A: The data belongs to the client, and we will always work with the office to ensure access to 
their data; however, the structure of data is proprietary to Carestream Dental. As well, in cases 
where access to the office’s data is given, we cannot verify in a court of law that the client’s data 
has not been tampered in cases where an office’s data is called into question. As such, we do 
not provide access to the database, as a precaution to the office. 

 

Q: Can I run the license server as a service? 

A: We have seen multiple offices who have found a way to encapsulate the license as a service; 
however, as we have done no testing in-house on this, we cannot support this setup, and will 
recommend changes to the office to run the license as a regular application on launch. 
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Q: Can I use a wireless network? 

A: OrthoTrac requires stable and expedient networking. Multiple errors can occur without a 
consistent data throughput, not limited to but including SQL disconnects, and load flow array 
errors that may disrupt the office’s work flow. As such, we do not recommend wireless networks 
for mission critical stations. 

Related Documentation and Resources 

Additional information available in the Resource Library: 

• Initial Training Workbook 

• Online Help 

• Release Notes 

• Link to our virtual agent, Cassidy 

o https://gosensei.com/pages/orthotrac-support 

Cassidy is Carestream Dental’s AI-powered virtual agent offering 24/7/365 online 
customer support. When you need a quick step-by-step guide or question on product 
needs, information is instantly available via Cassidy. 

https://gosensei.com/pages/resource-library
https://gosensei.com/pages/orthotrac-support

